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Legal Notices 

Information furnished is believed to be accurate and reliable. However, Oxford 
Technical Solutions Limited assumes no responsibility for the consequences of use of 
such information nor for any infringement of patents or other rights of third parties 
which may result from its use. No license is granted by implication or otherwise under 
any patent or patent rights of Oxford Technical Solutions Limited. Specifications 
mentioned in this publication are subject to change without notice and do not represent 
a commitment on the part of Oxford Technical Solutions Limited. This publication 
supersedes and replaces all information previously supplied. Oxford Technical 
Solutions Limited products are not authorised for use as critical components in life 
support devices or systems without express written approval of Oxford Technical 
Solutions Limited. 

All brand names are trademarks of their respective holders. 

The software is provided by the contributors “as is” and any express or implied 
warranties, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose are disclaimed. In no event shall the contributors be 
liable for any direct, indirect, incidental, special, exemplary, or consequential damages 
(including, but not limited to, procurement of substitute goods or services; loss of use, 
data, or profits; or business interruption) however caused and on any theory of liability, 
whether in contract, strict liability, or tort (including negligence or otherwise) arising in 
any way out of the use of this software, even if advised of the possibility of such 
damage. 

Copyright Notice 

© Copyright 2015, Oxford Technical Solutions. 

Revision 
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Contact Details 

Oxford Technical Solutions Limited 
77 Heyford Park 
Upper Heyford 
Oxfordshire 
OX25 5HD 
England 

Tel: +44 (0) 1869 238 015 
Fax: +44 (0) 1869 238 016 
 
http://www.oxts.com 
mailto:info@oxts.com 

 

 



NAVdisplay User Manual 

 

Revision: 150324 3 

 

Table of Contents 

Introduction 5 

Minimum requirements 6 

Installation 7 

Installing .NET 7 

Firewall 7 

Getting started 9 

Connection manager (NAVconnect) 10 

NAVconfig context menu 11 

Working with templates 13 

Docking and Undocking windows 14 

Pinning and unpinning windows 15 

Creating a template 15 

Saving a template 15 

Loading a template 15 



 

 

4 Oxford Technical Solutions

 

Widget types 17 

Adding widgets 18 

Analogue widgets 19 

Digital widgets 20 

Light widgets 21 

Measurement list widgets 22 

Graph widgets 23 

Send command bar 25 

Changing the language 26 

Default options 27 

Cone placement 29 

Drift test 30 

File replay 31 

Serial port 32 

Device status 33 

Test and Save module 34 

Test Status and Start Buttons 35 

General tab 35 

File tab 36 

Start Tab 38 

Stop Page 40 

Quick config 41 

Shortcuts and hotkeys 42 

Hotkeys 42 

Shortcuts 42 

Revision History 44 



NAVdisplay User Manual 

 

Revision: 150324 5 

 

Introduction 

NAVdisplay is a very powerful digital dashboard that provides real-time monitoring of 
INS devices. Information from one or more connected products can be displayed in a 
number of highly configurable ways, including analogue dials or numeric displays and 
programmable lights. This allows engineers working in the field to make complex at-a-
glance decisions, such as whether the system is ready to perform certain test scenarios. 

Figure 1. An “at-a-glance” NAVdisplay template to check the system accuracy 

 
This template has been created to quickly check the system accuracy. The buttons in the centre of the 
screen have all been configured with the required accuracy settings. By simply glancing at the screen and 
seeing they are mostly green, the user can be confident they system is at the accuracy they require. 

NAVdisplay interprets all OxTS data formats and works with real-time information 
being transmitted via Ethernet, CAN bus or serial RS232. It can also replay previously 
saved measurement files that are in OxTS formats. 

The design area in NAVdisplay is fully configurable and there is no limit to the number 
of measurements that can be watched, or to the number of templates that can be 
created. This freedom allows specific templates to be created for almost any test 
scenario that can be imagined, and is what makes NAVdisplay such a powerful and 
useful tool. 
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Minimum requirements 

The minimum system specifications required to support NAVdisplay are listed below. 

 1.6 GHz processor, Celeron, Pentium, i3 core, etc. with one thread 

 1 GB SDRAM 

 32-bit and 64-bit operating systems 

 Windows Vista (SP2 with platform update), Windows 7 and Windows 8 
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Installation 

NAVdisplay is installed as part of the NAVsuite software—which is delivered on a CD 
with your product, or it can be downloaded as a compressed zip file (please email 
support@oxts.com for details of how to do this). To install the NAVsuite software, 
double-click NAVSetup.exe to start the software setup and then follow the instructions 
in the wizard. 

NAVsuite contains the following programs: 

 NAVdisplay 

 NAVconfig 

 NAVgraph 

 RT Post-Process 

 Relevant OxTS manuals 

 Microsoft Visual C++ redistributable software (where not already installed) 

Installing .NET 

NAVsuite will also install the Microsoft .NET framework 4 if it is not already installed 
on your system. Alternatively you can download .NET free of charge from the 
Microsoft website. 

Firewall 

The first time NAVdisplay is run, a firewall message similar to the one shown in Figure 
2 may be triggered. This is because the program is attempting to listen for, and 
communicate with, OxTS devices on the network. The firewall must be configured to 
allow the program to talk on the network or it will not work as intended. 
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Figure 2. Window’s Firewall warning message 

 
Ensure both Private and Public networks are selected to ensure the software can continue functioning 
when moving from one type to another. 
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Getting started 

When NAVdisplay first runs, it looks similar to the screen shown in Figure 3. 

Note: before you can create a layout in NAVdisplay, the software must see at least 
one active data stream in NAVconnect, and at least one device with a tick in its 
Enabled column. 

Data streams can be sourced from a live product connected to the PC via Ethernet, 
CAN or serial RS232. A data stream can also be generated by replaying a previously 
saved measurement file using the File replay utility, which can be found under the 
Utilities menu on the main toolbar. This tricks NAVdisplay into thinking the device 
that recorded the data is available on the network. 

Until a data stream is available in NAVconnect, it is not possible to create a template. 
This is because NAVdisplay is capable of simultaneously monitoring several devices. 
So, to make it clear what data is being displayed, each display component (called a 
widget) is linked to a specific product serial number. Unless a data stream is available, 
NAVconfig can’t assign a serial number to the widget—so can’t create any display 
items. 

Figure 3. NAVdisplay initial screen 

 
The first time NAVdisplay runs, you will see something like this screen. In order to design a new 
template, a device must be available in the NAVconnect (docked to the top of the window). In this case 
you can see an RT3000 with the serial number 5370 is available, and the Enabled checkbox has been 
selected. It will now be possible to create a template. 
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Connection manager (NAVconnect) 

Connections between available devices and NAVdisplay are managed with 
NAVconnect. NAVconnect is a dockable window that can be toggled on and off using 
the View menu on the main toolbar. 

In the example shown in Figure 4, you can see there are multiple devices available on 
the OxTS network where this screenshot was taken. To create a new template using 
measurements from one or more of the available devices shown in NAVconnect, select 
the Enabled box in the left-hand column. 

Please note that the Enabled checkbox does not need to be checked in order to view 
streaming data once a template has been created. What the Enabled checkbox actually 
does is make selected devices available in the Widgets menu. The process of adding 
widgets is fully explained on page 18. 

Table 1 explains the fields listed in the NAVconnect window. 

Figure 4. Available devices shown in the NAVconnect window 

 
Checking items in the Enabed column makes them available in the Widget menu, so widgets can be 
added. Enabled does not need to be checked in order to view live data, only to add widgets. 
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Table 1. Description of the NAVconnect window 

Field Description 

Enabled When this box is checked, the device will show up in the Widgets menu allowing 
widgets to be added. It does not need to be checked to view live data. 

Tag id Information displayed here will appear in each widget’s header for easy identification 
of the source of the measurement. The Tag id can be renamed by double clicking on it 
and typing the new name. 

Association tag This is not currently used in NAVdisplay. 

Address Displays the device’s IP address when data is transmitted via Ethernet and CAN. 
Serial connections show up as Serial: {stream ID}-{device Id}. Serial connections do 
not show the device’s IP address. The information in brackets shows the packet 
container type and the codec being used (e.g. NAV::NCom). In that case NAV stands 
for navigation information and NCom is the codec. 

Product name Displays the product family name of the device. Blank when replaying an RD file. 

Firmware id Displays the firmware version currently running on the device. Blank when replaying 
files. 

Serial number Displays the serial number of the device. 

Connection lag The connection lag bar represents a delay of 10 seconds. If the delay is too great 
NAVdisplay disables the device in the list. 

Bytes received Displays the number of bytes received. 

 

NAVconfig context menu 

A context menu to quickly access key features is available within NAVconnect. It is 
accessed by right-clicking on any cell (except Enabled, Tag id or Connection lag) of an 
enabled device. 

Figure 5. NAVconnect context menu 

 
NAVconfig’s context menu is accessed by right-clicking on any of the highlighted columns within an 
enabled device. 

 Add single measurement. Provides the same functionality as selecting one of the 
single measurement widgets from the main toolbar. 
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 Hide device. This command is disabled unless the device’s connection lag has timed 
out. It removes devices that have dropped off the network from the list. 

 Load widget group file. This command is currently not implimented. 

 Zero distance. This command saves the current “distance travelled” value of the 
device. 



NAVdisplay User Manual 

 

Revision: 150324 13 

 

Working with templates 

Unlike other OxTS software applications, NAVdisplay does not have a fixed user 
interface. Instead, it provides a blank canvas that can be filled using a number of items 
called widgets. In this way you can build exactly the interface you need, showing only 
important information. 

In terms of layout there are three different kinds of control items; fixed, dockable and 
floating. Examples of these are shown in Figure 6. 

Figure 6. Overview of window types 

 
NAVdisplay works just as well on multi-monitor configurations; however, you should note that the main 
application window always opens on the primary monitor. 

Fixed item: The main toolbar and the Send command bar are examples of fixed items. 
No matter what happens they always appear in the same place within the parent 
NAVdisplay window. 

Dockable item: Windows like NAVconnect and widgets such as analogue dials, 
graphs and digital displays, are dockable items. This means they can be docked within 
the parent window or they can be torn off and maintain their position anywhere on the 
desktop. 

Floating item: The third style of window is a floating window, which cannot be 
docked inside the main NAVdisplay window at all. Examples of floating windows 
include the File replay window and the Device status windows. These windows 
remember their location when closed, and open in the same place. 
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Docking and Undocking windows 

Docking and undocking windows in NAVdisplay is easy. To undock a window, simply 
click and drag with the mouse on its title area. Once a window has been undocked it 
can be placed anywhere on the desktop, and will remember its position. You can also 
undock a window by double clicking its title bar. 

Figure 7. Undocking a window 

 
To undock a window, click and hold on the window’s title area and drag it out of its container. 

Docking a window is also easy. Click and hold on the title area of the window you 
want to dock, and drag it to where you would like to place it. When the dragged 
window is held above a potential location, a position anchor will appear to help you 
place the widget. The docking process is shown in Figure 8. 

Figure 8. Docking a window 

 
To undock a window, click and hold on the window’s title area and drag it out of its container. 

Once a window has been undocked it behaves like a normal window and can be moved, 
resized, minimised and maximised as normal. That single undocked window can also 
act as a container for other windows. This means an undocked window can be dragged 
onto another undocked window—creating a single undocked window that now contains 
two items. 
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Pinning and unpinning windows 

As well as docking and undocking, some dockable windows have the ability to be 
pinned and unpinned. Windows that can be pinned feature an extra icon on the right-
hand side of their title bar, as shown in Figure 9. Clicking the pin icon toggles the 
feature on and off. When enabled, the pinning feature collapses the item into a tab on 
the edge of its parent container. As soon as the mouse pointer hovers above the tab, the 
item will spring open to its original position. 

Figure 9. Window featuring a pinning icon 

 
Windows that feature the pin icon in the title bar can be collapsed into a tab to save space. When the 
mouse is hovered over the tab, the window will spring open again. 

Creating a template 

NAVdisplay opens with a blank template. To add widgets to this template you must 
first enable a device in NAVconnect. Once this is done widgets can be added to the 
template and moved around as required. 

Saving a template 

Templates can be saved via the main toolbar. To save a template click File, then select 
Save and finally select Template from the pop out menu. A dialog box will appear 
where a file name a location can be entered. Click Save to complete the process. 

Loading a template 

Existing templates are loaded using the Open command in the File menu. The Open 
command has a pop out submenu where a template can be chosen. At this point it is 
possible to Browse for a template location or to select a recently opened template from 
the pop out list. 

The Device association window, shown in Figure 10, will appear by default when 
opening a template. If the device that was used to create a template is currently 
available on the network, that device will automatically be selected, and the template 
can be opened by selecting OK. Alternatively, a new device can be selected and any 
widgets previously associated with the other device will be re-assigned to a new device 
that is currently available. 
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The default behaviour can be changed by selecting the “Only display this screen if 
device not found” option at the bottom of the window. When this option is checked, the 
Device association window will not appear, as long as the device used to create a 
template is available. To reverse this option, and force the Device association window 
to always show, select “Always display serial number mapping screen” in the Options 
menu of the main toolbar. 

Figure 10. Device association window 
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Widget types 

The visual devices that NAVdisplay uses to relay data are called widgets—and there 
are 5 different styles to choose from as shown in Table 2. 

Table 2. Widget overview 

Widget name Example Description 

Analogue 
(single measurement) 

 

The analogue measurement widget displays a single 
measurement in the form of an analogue dial. To 
configure the settings for each gauge, right-click on 
the widget and select Configure. 

Digital 
(single measurement) 

 

The digital measurement widget displays a single 
measurement as digits. The colour of the text can 
change to indicate the measurement is within a 
defined range. To configure the settings, right-click 
on the widget and select Configure. 

Light 

(single measurment) 

 

The light widget watches a single measurement and 
changes colour depending on the value of that 
measurement. Three definable colour ranges can be 
set for the light. If the measurement value is not 
within any of the defined ranges the light will turn 
black. To configure the settings, right-click on the 
widget and select Configure. 

Measurement list 

 

The measurement list widget displays the value of 
multiple measurements in digital form. As with a 
digital widget, the text colour indicates whether the 
value is within a user-defined range. This is a good 
way to view multiple measurements in a small 
space. To configure the settings, right-click on the 
widget and select Configure.  

Graph 

 

The graph widget provides a scrolling time-based 
plot of one or more measurements. To add 
measurements, configure the graph and toggle the 
visibility of the legend, right-click on the graph area. 
To remove or configure individual measurements 
you must find that measurement within the legend 
and right-click on it. 
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Adding widgets 

The Widget menu in the main toolbar is used to add new widgets as shown in Figure 
11. In order to successfully execute any of the commands in the Widgets menu, at least 
one device listed in NAVconnect must have its Enabled checkbox selected. This allows 
NAVdisplay to associate those widgets with the relevant device. 

Figure 11. Widgets menu structure 

 
One or more devices must be enabled in NAVconnect before it is possible to create widgets using the 
Widgets menu. 
 

Widgets added through the Widgets menu initially appear docked in the main 
application window. However, they can easily be undocked and rearranged as 
described on page 14, and once a template is finished, it can be saved for later use. 
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Analogue widgets 

Analogue widgets only display a single measurement, which is chosen when the widget 
is created. The appearance of each analogue widget, and the measurement it displays, 
can be changed via the configuration window. 

Figure 12 shows the analogue widget configuration window, which is accessed by 
right-clicking on an analogue widget and selecting Configure. The gauge 
configurations are clearly labelled, and the effect of each one is previewed on the right-
hand side. 

As well as configuring each gauge, the measurement assigned to the widget can also be 
changed using the measurement configuration controls in the lower half of the window. 

The * by the default unit means this widget will be affected by the global default 
options that are defined using the Options window from main toolbar. To force a 
widget to always use a specific unit, choose one without the *. 

Figure 12. Analogue widget configuration menu 

 
To access the analogue configuration window, right-click on an analogue widget and select configure. 
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Digital widgets 

Digital widgets only display a single measurement which is chosen when the widget is 
created. The appearance of each digital widget, and the measurement it displays, can be 
changed at any time via the configuration window. 

The digital widget configuration window is accessed by right-clicking on the widget 
and selecting Configure. This will open the window shown in Figure 13. The 
measurement displayed by the widget can be changed using the Measurement 
configuration controls. 

To visually speed up the checking of the NAVdisplay window, the text used in a digital 
control can change depending on the value of the measurement. This is set using the 
valid range controls. The Minimum value is equivalent to ≥, while the Maximum value 
is equivalent to ≤. 

Figure 13. Digital widget configuration menu 

 
To access the digital configuration window, right-click on a digital widget and select configure. 
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Light widgets 

Light widgets only display a single measurement, which is chosen when the widget is 
created. The appearance of each light widget, and the measurement it references, can be 
changed via the configuration window. 

The configuration panel for light widgets is accessed by right-clicking on the widget 
and selecting configure. This will open the window shown in Figure 14. Light widgets 
have 3 configurable states, which makes them very useful for creating templates that 
can be read ‘at-a-glance’. Three colour and measurement ranges can be defined. In each 
case the From value is equivalent to ≥, while the ‘to’ value is equivalent to ≤. 

The measurement the light widget displays can be changed using Measurement 
configuration controls in the lower half of the window. 

Figure 14. Light widget configuration menu 

 
To access the light configuration window, right-click on a digital widget and select configure. 
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Measurement list widgets 

Measurement list widgets display one or more digital measurements in a space-efficient 
way. When a measurement list widget is first created, the Add measurements window 
will appear. This is the leftmost image in Figure 15. 

To add a measurement to the list, simply select one of the enabled devices from the tree 
view on the left-hand side of the window, and then click on the checkbox next to the 
name of the measurement to be added. Several measurements can be added at once. 
The Add measurements window can also be accessed by right-clicking on the widget 
itself, in order to add additional measurement later on. 

The appearance of individual measurements is controlled by right-clicking a 
measurement and selecting Configure. This will open the rightmost window in Figure 
15. From this window the measurement being displayed can be changed using the 
Measurement configuration controls. The colour of the display text can also be defined 
based on the measurement value, by using the Valid range controls. 

The up/down buttons in the top right of the window allow multiple measurements 
present in the list, to be configured without the need to close the window. 

Measurements are removed from the measurement list by selecting the measurement 
and pressing the delete key, or by right-clicking on the measurement and selecting 
Remove. 

Figure 15. Measurement list widget configuration menu 

  
Two configuration windows control the appearance of Measurement lists. The leftmost window is used 
to add measurements and is accessed by right-clicking on the widget. The rightmost window is accessed 
by right-clicking on a specific measurement. 
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Graph widgets 

Graph widgets display one or more measurements in a time-based plot. The appearance 
of each graph widget, and the measurements it displays, can be changed at any time by 
right-clicking in different areas of the graph. 

Measurements are added to graph widgets by right-clicking on the plot area of the 
graph and selecting Add measurement from the context menu. This will open the 
window show on the left of Figure 16. To add a measurement to the list, simply select 
one of the enabled devices from the tree view on the left-hand side of the window, and 
then click on the checkbox next to the name of the measurement to be added. Several 
measurements can be added at once. 

Measurements can be removed, and their appearance changed, by right-clicking on a 
measurement in the graph legend. If the graph legend is not visible, it can be displayed 
by right-clicking on the plot area and selecting View legend. To remove the 
measurement select Remove. To remove all measurements select Remove all. 

To edit the appearance of the measurement that was right-clicked, select Configure. 
This will open the window show on the right of Figure 16. The up/down buttons in the 
top right of the window allow multiple measurements present in the list to be 
configured without the need to close the window. 

Figure 16. Graph widget configuration menu 

  
The Add measurement window is accessed by right-clicking on the graph plot area and selecting 
Configure. The Configure measurement window is accessed by right-clicking on a measurement in the 
graph legend. If the legend is not visible, right-click on the graph plot area and select View legend. 
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The appearance of the graph itself is controlled through the Graph configuration 
window as shown in Figure 17. This window is opened by right-clicking on plot area 
and selecting Configure. 

While they are not displayed by default, a graph title, x-axis caption and y-axis caption 
can be added from the Graph configuration window. The scale of the y-axis, which is 
set to automatic by default, can also be manually defined. 

The Miscellaneous controls in the lower part of the window allow you to change the 
background colour of the graph plot area, the refresh rate of the widget and the History 
of the graph—the time period that is displayed. 

Figure 17. Graph configuration window 

 
The Graph configuration window is opened by right-clicking on the plot area and selecting Configure. 
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Send command bar 

The Send command bar, see Figure 18, is a fixed window located at the bottom of the 
main application window. Its visibility is toggled on and off and via the View menu in 
the main toolbar. 

The purpose of the Send command bar is to send advanced commands to selected 
devices that are visible to NAVdisplay. It is mainly used by OxTS employees for 
diagnostic purposes but is safe to use if you are familiar with advanced commands. 

Figure 18. Send command toolbar 

 
The Send command bar (bottom of the window) is used to send advanced commands to the selected 
device. Its visibility is toggled on and off use the View command on the main toolbar. 
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Changing the language 

NAVdisplay can operate in several languages. To change the language, select the 
language from the Language menu on the main menu. The language can be changed at 
any time without affecting the operation of the application. 

The application uses the PC’s regional settings to choose whether numbers are 
represented in the English or European format (dot or comma as the thousands 
separator). 

At the time of writing, not all languages are yet implemented. 

Figure 19. Languages supported 
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Default options 

The Options window shown in Figure 20 is accessed by selecting Options on the main 
toolbar. The default settings NAVdisplay uses for measurement units, timings and file 
locations is configured here. 

Changing the default unit changes how the measurements appear in the measurement 
configuration windows of the main display. When working with CAN data, it is not 
possible to change the default units as they are fixed by the CAN DBC file used to 
create the data. 

The fields in the Options area are shown in Figure 20 and described in Table 3. 

Figure 20. Options window 
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Table 3. Description of the Options window  

Field Description 

Data store update rate (ms) An integer value of 10 ms to 5000 ms. This is how often the data store 
should process the data it has stored in its buffers. 

Widget item refresh rate An integer value of 100 ms to 30000 ms. This is how often each widget 
asks the data store for updated data. If this value is changed, the refresh 
rate for all the open measurements will change to the value specified in 
the options box. 

This value can be individually set for different widgets using the 
measurement configuration tool. 

Device lost timeout (ms) An integer value of 5000 to 30000 ms. 

This defines how long NAVconnect should wait before deeming the 
device is no longer present on the network. After this time, it will grey 
out the device in the list. 

Default units The default units can be set for each measurement type. When 
configuring individual widgets, the default unit is shown as an *. To 
override the default unit, choose a unit that does not have * in it. 

Widget group file 
directories 

This is the default file save location(s) for widget groups. There can be 
more than one location so all directories locations are visible to assign to 
a device within the NAVconnect window. New locations can be set using 
the + button. 

Always display serial 
number mapping screen 

This option forces the Device association window to be displayed when 
opening templates. See page 16. 
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Cone placement 

This utility will be covered in a future update. Some information can currently be found 
in the Enginuity manual. 
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Drift test 

This utility will be covered in a future update. Some information can currently be found 
in the Enginuity manual. 
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File replay 

The File replay utility reads data from an NCOM, RCOM, XCOM or MCOM file and 
uses it to simulate a device broadcasting live data on the network. This allows 
templates to be created when no physical device is connected and for the functionality 
of templates to be checked. 

The utility can also control the playback speed too. This feature, and the option to loop 
the playback of files, becomes available once playback commences. 

Multiple instances of the File replay utility can be run at once, enabling one or more 
devices to be simulated. However, if the File replay window is closed at any time, the 
simulated device will become unavailable. 

Figure 21. File replay window 

  
The File replay utility simulates a device broadcasting on the network. Playback speed can also be 
adjusted. 
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Serial port 

OxTS devices are normally connected to PCs via Ethernet. However, the Serial port 
utility found in the Utilities menu enables navigation data to be received via serial 
RS232 connections. The settings used on the Serial port window will need to match the 
serial connection settings that your OxTS product has been configured with. 

This window must be left open at all times while viewing the data. If it is closed 
NAVdisplay will immediately stop reading from the device. Multiple instances of the 
Serial port window can be opened at once. 

Figure 22. Serial port window 

 
The Serial port window is accessed via the Utilities menu on the main menu. 
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Device status 

The device status utility is a software tool that allows the feature code status of selected 
devices to be checked. The utility is launched by selecting Device status from the 
Utilities menu on the main toolbar. This will open the window shown in Figure 23. 

The Device status window provides a list of all features that can be enabled using 
feature codes. The Setting column has four states: 

 Enabled 

 Disabled 

 Not supported 

 Expired 

The issue date and expiry data for any enabled features is shown in the relevant 
column. For more information on feature codes, or to enable available features, please 
email sales@oxts.com. 

Figure 23. Device status window 

 
The Device status window is accessed via the Utilities menu on the main toolbar. It shows what feature 
codes have been enabled on the selected device. 
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Test and save module 

The Test and save utility can be found in the Utilities menu of the main toolbar. This 
utility is designed to automatically extract and save test data that fits the criteria defined 
on the stop start tabs. It is useful because it allows real-time evaluation of the data 
without the need to stop and select data to be analysed in an external program. 

Please note this utility only works with actual products that are streaming data. It will 
not work if you are replaying a file with the File replay utility. 

When the Test and save option is selected from the Utilities menu, the Data logger 
window shown in Figure 24 will appear. Several instances of this utility can be 
launched simultaneously, allowing multiple tests to be conducted in parallel. 

The interface features four tabs. The General tab summarises the data defined on the 
other three tabs for quick reference. The File tab is where file location and names are 
defined for any test results that are produced, while the Start and Stop tabs enable the 
test conditions to be defined. Below the tabbed section there are three buttons that 
remain the same for each tab page. 

Each tab is described in more detail below along with the function of the buttons. 

Figure 24. Test and save Window 
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Test status and Start buttons 

The Test status box at the bottom of the window shows whether the unit is ready to 
record a test, and whether a test is currently recording or not. When the Ready button is 
red, the unit is ready. When the Running button is red, a test is currently running as per 
the defined settings. 

Test can be started manually at any time by pressing the Start now button. Once a test 
has started, either manually or automatically, the Start now button will display Stop 
now instead, and can be used to manually stop a test at any point. 

General tab 

The General tab summarises the file settings and tests defined on the other tabs. Table 4 
below lists all parameters and describes their purpose. 

Table 4. Description of General tab parameters 

Parameter Description 

Working directory Displays the directory where all test files will be saved. 

Last file(s) written Displays the name of the last test file recorded. 

Next file Displays the name of the next test file to be recorded. 

File size Displays the size of the file currently being recorded. 

Logging start condition Displays all options selected for starting the test. 

Logging stop condition Displays all options selected for stopping the test. 

Sound Displays whether any of the start or stop sounds are active. 
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File tab 

The File tab shown in Figure 25 is where the path used to store any test data is defined 
and where the automatic file naming function is configured. 

Figure 25. File Page 

 

 

Working directories can be defined by copying and pasting a path directly into the text 
box, or by clicking the “…” button and navigating to a target folder. Pressing the folder 
icon at the end opens the specified target folder in Windows Explorer. 

When test files are created, they will be named with the text entered into the File name 
text box and suffixed with the auto-incrementing number displayed on the -000 button 
to the right hand side. Clicking the -000 button opens the Data file numbering window 
shown in Figure 26, where the suffix can be formatted. 
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Figure 26. Enter Start Number Window 

 
 

Once a test file has been created, it can be automatically opened in NAVgraph. To 
enable this option, select the Open NAVgraph automatically after each test option. The 
menu below this option allows a NAVgraph template to be selected. To access 
NAVgraph templates not located in the default location, use the “…” button to navigate 
to this folder. The templates will then appear in the drop-down menu. 
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Start Tab 

The start tab shown in Figure 27 is used to define the conditions under which a test file 
will be started. When an INS is configured using NAVconfig, trigger events can be 
defined. These are captured by NAVdisplay and can be used to start and stop tests. 

Figure 27. Start tab 

 
 

The tag ID of any live products that are visible to NAVdisplay will show up in the drop 
down menus. To start a test on the falling edge trigger of a product, select the On 
falling trigger of option, and choose the correct device from the adjacent menu. 

Selecting the Start Line of option will start the test when the chosen INS crosses a 
predefined line in the correct direction. This option cannot be selected until a valid start 
line is either defined or selected. Pressing the Edit... button opens the Define Start Line 
window as shown in Figure 28. 

To create a new start line, enter the desired name in the File Name box at the top of the 
window and choose a location by pressing the “...” button. 
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Figure 28. Define Start Line window 

 
 

To set a start line using live data from a device, move the vehicle to the desired start 
line position and ensure it is pointing in the right direction, then press Fix here.... This 
will set the start line at the current position perpendicular to the current heading. 

The desired length of the start line can be selected using the Line length dropdown list 
box. The latitude and longitude of each end of the start line are displayed lower down. 
These edit boxes can also be used to manually type in the co-ordinates of a desired start 
line. 
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Stop Page 

The Stop tab shown in Figure 29 is used to define the conditions under which a test file 
will be stopped. The triggers are defined in each INS using NAVconfig. Tests can be 
stopped on the rising or falling edge of a trigger, when crossing a stop line or after an 
elapsed time period. 

Figure 29. Stop Page 

 
 

To end a test using a trigger, select either the rising or falling edge option and select the 
ID of the trigger device from the relevant drop-down menu. 

Stop lines are defined in the same way as start lines were in the previous section. 

When On time elapsed is selected, the test will automatically end after the defined 
number of seconds has passed. 
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Quick config 

This utility will be covered in a future update. 
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Shortcuts and hotkeys 

Hotkeys 

Hotkeys provide access to many of NAVdisplay’s features without the use of a mouse. 
This is useful in the field, where it is often hard to see the mouse pointer in bright 
sunlight. 

To access hotkeys, press the Alt key once and a line will appear under certain letters in 
the GUI. Pressing the corresponding letter on the keyboard, as the underlined letter on 
the GUI, has the same effect as clicking on that menu item with the mouse. 

Figure 30. Hotkeys 

 
Hotkeys are activated by pressing the Alt key, which underlines certain letters. Pressing the relevant key 
on the keyboard causes the same behaviour as clicking that menu with the mouse. In this example the Alt 
key was pressed, followed by the F key. Pressing the X key would cause the application to exit. 

Shortcuts 

A number of keyboard shortcuts can be used when working with widgets. The key 
combinations must be held down simultaneously unlike the hotkeys, which are pressed 
in sequence. 

ALT+C Opens the configuration window of the currently selected widget. On 
multi-measurement widgets a single measurement must be selected 
first. 

ALT+A Opens the Add measurements window (Measurement list and Graph 
widgets). 
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ALT+N Selects the next measurement when working with Configure 
measurement windows. 

ALT+P Selects the previous measurement when working with Configure 
measurement windows. 
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Revision History 

Table 5. Revision History 

Revision Comments 

150324 Initial Version. 

  

 

 

 

  


